Harnessing the Power of Excel

Tips and Tricks for Financial Professionals

June 19, 2019
**Housekeeping**

**CPE Credit/Technical Support**

- **Important:** Three (3) CPE words will be provided during the presentation. Please write them down – **we will not provide them again via GoToWebinar or email (no exceptions).**

- Please complete the electronic survey that will appear automatically at the end of the webinar.

- Attendees seeking CPE for this presentation must complete the survey and **enter all three CPE words.** You cannot claim CPE unless we receive a completed evaluation with the correct words.

- This presentation will be recorded and made available to download at [www.grfcpa.com/webinars](http://www.grfcpa.com/webinars).

- Technical questions about the survey can be addressed to Dominic Acosta at [dacosta@grfcpa.com](mailto:dacosta@grfcpa.com).
## Webinar Objectives

### Learning Objective
To understand the tools necessary for planning, forecasting and budgeting in Microsoft Excel.

### Instructional Delivery Methods
- Group Internet-based

### Recommended CPE
- 1.0 CPE Credit

### Recommended Fields of Study
- Accounting

### Prerequisites
- None required

### Advance Preparation
- None

### Program Level
- Basic

### Course Registration Requirements
- None

### Refund Policy
- No fee is required to participate in this session.

### Cancellation Policy
- In the event that the presentation is cancelled or rescheduled, participants will be contacted immediately with details.

### Complaint Resolution Policy
Gelman, Rosenberg & Freedman CPAs is committed to our seminar participants’ 100% satisfaction and will make every reasonable effort to resolve complaints as quickly as possible. Please contact kdavis@grfcpa.com with any concerns.

### Disclaimer
This webinar is not intended as, and should not be taken as, financial, tax, accounting, legal, consulting or any other type of advice. Readers and users of this webinar information are advised not to act upon this information without seeking the service of a professional accountant.

---

**GELMAN, ROSENBERG & FREEDMAN Certified Public Accountants**
Our Team

Meet Your Instructors

Ian Shuman, CPA
Outsourced Accounting and Advisory Services Partner

Yevgeniy Sukhenko, CPA
Outsourced Accounting and Advisory Services Supervisor

Brandon Mullens
Outsourced Accounting and Advisory Services Senior Accountant
Tips & Tricks

Home Tab

• Conditional formatting
Tips & Tricks

*Insert Tab*

- Objects
Tips & Tricks

Formulas Tab

• Error Checking
Tips & Tricks

Data Tab

• Filter

• Text to Columns

• Remove Duplicates
Tips & Tricks

Review Tab

• Protecting worksheets/workbook
Tips & Tricks

View Tab

• New Window
Drop-down Lists

- Help ensure data integrity by restricting user input to a list
Drop-down Lists

Continued

Where your restricted list exists
Poll Question #1

How would you rate your overall Excel skills?

A) Basic
B) Intermediate
C) Advanced
D) Power User
LEFT and RIGHT

• Returns a # of characters from another cell starting at the LEFT (or RIGHT)
  
• =left(text,Num_chars) or =Right(text,Num_chars)
  o Text: What cell to return characters from
  o Num_chars: How many characters to return

• Often used to break out a last name or to separate dimension from an account number
  o The 4 LEFT-side characters of 5200-A gives you the account number (5200)
  o The 1 RIGHT-side character of 5200-A gives you the department (A)
MID

- Same as LEFT but you set a starting point
- \( \text{=mid(text,Start\_num,Num\_chars)} \)
  - Text: What cell to return characters from
  - Start\_num: Starting point (location number, starting at 1 on the left)
  - Num\_chars: How many characters to return
- Example: the 4 characters from XX5200-A starting from 3 gives you the account number (5200)
FIND

• Returns the location of something you are looking for within the text from another cell

• =Find(Find_text,Within_text,Start_num)
  o Find_Text: What text to look for (usually a cell reference or text in quotes such as “,”)
  o Within_Text: Where to look for it (a cell reference)
  o Start_Num: (OPTIONAL) Where to start looking (default is first character on LEFT side)

• Example: To get the last name out of “Smith, Jane” you can ask for all characters up to one space fewer than the location of the comma
SUMIF

- Adds together a group of numbers that meet a given criteria
- \( =\text{SUMIF(Range,Criteria,Sum\_range)} \)
  - Range: the cells you want to evaluate for the criteria
  - Criteria: this is what you are looking for
  - Sum\_range: The values to add up based on which values in the range match the criteria

- The range and the sum range should almost always be level with each other. You are adding up all the values in one column based on the rows for which the value in a different column meets the criteria

- Example: sum of the 2nd column for all the Pauls

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Paul</td>
<td>90.00</td>
</tr>
<tr>
<td>John</td>
<td>94.00</td>
</tr>
<tr>
<td>Paul</td>
<td>80.00</td>
</tr>
</tbody>
</table>
VLOOKUP

• Looks a table of data, finds a value on the left (always on the left) and returns the value in another column from the same row

• =vlookup(Lookup_value,Table_array,Col_index_num,Range_lookup)
  o Lookup_value: The value you are looking for
  o Table_array: The table of data to look in (this is a group of columns or a selected rectangle of cells)
  o Col_index_num: The column number of the data you want returned
  o Range_lookup: (TRUE/FALSE) true gives “closest match”, false gives an exact match. TIP: True is the default if left blank but its really unpredictable so I ALWAYS use false.

• Example: look up the name and go to column 3 to return the state for that name

<table>
<thead>
<tr>
<th>Name</th>
<th>Dept</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>100</td>
<td>VA</td>
</tr>
<tr>
<td>Paul</td>
<td>200</td>
<td>DC</td>
</tr>
<tr>
<td>George</td>
<td>150</td>
<td>MD</td>
</tr>
<tr>
<td>Ringo</td>
<td>200</td>
<td>WV</td>
</tr>
</tbody>
</table>
COUNTIF

- Counts the number of times a cell value appears in a different range of cell values
- Useful for:
  - Identifying duplicates in a range of cells
  - Quickly identifying differences between data sets
- \( = \text{countif}(\text{range, criteria}) \), where:
  - Range \( \rightarrow \) range of cells where you want to count # of times that criteria appears
  - Criteria \( \rightarrow \) what you are looking for in the range
Poll Question #2

How often do you use pivot tables?

A) Never
B) Occasionally
C) Regularly
D) All day, every day
What Are Pivot Tables?

• A powerful feature offered by excel
• Data summarization tool with the ability to quickly summarize large amounts of data
• Single best tool for analyzing data without using formulas
How Can Pivot Tables be Used?

- Summarize large amounts of data
- Data analysis
- Group data by field
- Filter a particular group of data
- View the same data in different ways
## Creating a Pivot Table

### Create Source Data

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Manager</td>
<td>State</td>
<td>Type</td>
<td>Amount</td>
</tr>
<tr>
<td>John</td>
<td>VA</td>
<td>Flowers</td>
<td>75.00</td>
</tr>
<tr>
<td>John</td>
<td>MD</td>
<td>Dry Cleaning</td>
<td>75.00</td>
</tr>
<tr>
<td>John</td>
<td>DC</td>
<td>Catering</td>
<td>81.26</td>
</tr>
<tr>
<td>Paul</td>
<td>PA</td>
<td>Catering</td>
<td>90.00</td>
</tr>
<tr>
<td>Paul</td>
<td>DC</td>
<td>Catering</td>
<td>1,045.20</td>
</tr>
<tr>
<td>Paul</td>
<td>VA</td>
<td>Catering</td>
<td>451.10</td>
</tr>
<tr>
<td>Paul</td>
<td>MD</td>
<td>Catering</td>
<td>420.00</td>
</tr>
<tr>
<td>Paul</td>
<td>WV</td>
<td>Flowers</td>
<td>94.00</td>
</tr>
<tr>
<td>George</td>
<td>PA</td>
<td>Flowers</td>
<td>751.00</td>
</tr>
<tr>
<td>George</td>
<td>MD</td>
<td>Dry Cleaning</td>
<td>624.50</td>
</tr>
<tr>
<td>Ringo</td>
<td>MD</td>
<td>Flowers</td>
<td>460.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>VA</td>
<td>Dry Cleaning</td>
<td>417.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>VA</td>
<td>Dry Cleaning</td>
<td>982.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>VA</td>
<td>Dry Cleaning</td>
<td>134.50</td>
</tr>
<tr>
<td>Ringo</td>
<td>DC</td>
<td>Dry Cleaning</td>
<td>654.15</td>
</tr>
<tr>
<td>Ringo</td>
<td>DC</td>
<td>Dry Cleaning</td>
<td>874.01</td>
</tr>
<tr>
<td>Ringo</td>
<td>DC</td>
<td>Dry Cleaning</td>
<td>61.40</td>
</tr>
<tr>
<td>Ringo</td>
<td>DC</td>
<td>Catering</td>
<td>84.36</td>
</tr>
<tr>
<td>Ringo</td>
<td>DC</td>
<td>Catering</td>
<td>84.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>WV</td>
<td>Catering</td>
<td>909.00</td>
</tr>
</tbody>
</table>
Creating a Pivot Table

Continued

• To insert table on a particular sheet, select the cell where you’d like that table to start, select Pivot Table from the Insert Menu, then highlight the source data.

• To create a table on a new sheet, highlight the source data, then select Pivot Table from the Insert Menu.
Creating a Pivot Table

Continued

Once the pivot table is created, a blank table will appear with access to the pivot table fields menu.
Creating a Pivot Table

Continued

• Next, you will select the fields you would like to use
Creating a Pivot Table

Continued

• Here is a view of the finished pivot table

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Sum of Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>2,884.38</td>
</tr>
<tr>
<td>John</td>
<td>81.25</td>
</tr>
<tr>
<td>Paul</td>
<td>1,045.20</td>
</tr>
<tr>
<td>Ringo</td>
<td>1,757.92</td>
</tr>
<tr>
<td>MD</td>
<td>1,659.50</td>
</tr>
<tr>
<td>George</td>
<td>1,084.50</td>
</tr>
<tr>
<td>John</td>
<td>75.00</td>
</tr>
<tr>
<td>Paul</td>
<td>420.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>80.00</td>
</tr>
<tr>
<td>PA</td>
<td>841.00</td>
</tr>
<tr>
<td>George</td>
<td>751.00</td>
</tr>
<tr>
<td>Paul</td>
<td>90.00</td>
</tr>
<tr>
<td>VA</td>
<td>2,059.60</td>
</tr>
<tr>
<td>John</td>
<td>75.00</td>
</tr>
<tr>
<td>Paul</td>
<td>451.10</td>
</tr>
<tr>
<td>Ringo</td>
<td>1,533.50</td>
</tr>
<tr>
<td>WV</td>
<td>1,003.00</td>
</tr>
<tr>
<td>Paul</td>
<td>94.00</td>
</tr>
<tr>
<td>Ringo</td>
<td>909.00</td>
</tr>
<tr>
<td>Grand Total</td>
<td>8,047.48</td>
</tr>
</tbody>
</table>
Creating a Pivot Table

Continued

• Another view of the finished pivot table
Tips/Tricks

• No blank columns/rows in source data
• No blank data cells in source data
• Source data must have titles
• Remove totals from source data
• Refresh pivot table if change is made to source data: Analyze Tab ➔ Refresh
• Name a pivot table by: Analyze Tab ➔ Pivot Table ➔ Pivot Table Options
• Rename column headings by manually overwriting existing column headings
• Use Value Field Settings to choose between different calculation functions or use multiple calculation functions
Poll Question #3

Can better use of Excel help save time in your company’s accounting processes?

A) Yes
B) No
C) Not sure
Questions

Ian Shuman, CPA
ishuman@grfcpa.com

Yevgeniy Sukhenko, CPA
ysukhenko@grfcpa.com

Brandon Mullens
bmullens@grfcpa.com

Gelman, Rosenberg & Freedman
Certified Public Accountants

4550 Montgomery Avenue, Suite 650 N
Bethesda, MD 20814
301-951-9090

www.grfcpa.com
twitter.com/grfcpas
facebook.com/grfcpas
instagram.com/grfcpas
linkedin.com/company/gelman-rosenberg-&-freedman-cpas
Disclaimer

This webinar is not intended as, and should not be taken as, financial, tax, accounting, legal, consulting or any other type of advice. While we use reasonable efforts to furnish accurate and up-to-date information, we do not warrant that any information contained in or made available in this webinar is accurate, complete, reliable, current or error-free. We assume no liability or responsibility for any errors or omissions in the content of this webinar.

The use of the information provided in this webinar does not establish any contractual or other form of client engagement between Gelman, Rosenberg & Freedman P.C. and the reader or user. Any U.S. federal tax advice contained in this webinar is not intended to be used for the purpose of avoiding penalties under U.S. federal tax law. Readers and users of this webinar information are advised not to act upon this information without seeking the service of a professional accountant.